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Introduction to Geospatial Technology

Lesson Overview:

A geographic information system (GIS) integrates hardware, software, and data for capturing,
managing, analyzing, and displaying all forms of geographically referenced information.

GIS allows us to view, understand, question, interpret, and visualize data in many ways that
reveal relationships, patterns, and trends in the form of maps, globes, reports, and charts.

A GIS helps you answer questions and solve problems by looking at your data in a way that is
quickly understood and easily shared.

Skills:

1. Learn about what GIS is and how it is used

2. Learnthe components of a GIS

3. Use Google searches to find information about how GIS is used

Standards Of Learning:

Virginia Standards of Learning: Earth Science (ES.3); World Geography (WG. 1); Computer
Technology (C/T8.1, C/T8.4)

National Science Standards: Content Standard A (Science as Inquiry); Content Standard D (Earth
and Space Science); Content Standard E (Science and Technology)

References:

Caplan, J. M. (2010). GIS for Public Safety: An Annotated Guide to ArcGIS Tools and Procedures.
Newark, NJ: Rutgers Center on Public Security.

WWwWWw.esri.com

Questions to be answered:

1. WhatisaGIS?

What are the five components of GIS?

What are three fields that use or rely on GIS information?
What job positions frequently use GIS?

vk wnwN

How is a GIS professional educated?
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What is a GIS?

A geographic information system (GIS) is a computer software application for managing,
editing, analyzing and displaying data which is spatially referenced to the Earth. GIS is a tool
with which data can be layered with base maps that represent the landscape of the area where
the data is associated. Base maps could represent the street network, buildings, census tracts,
or local land use patterns.

Imagine GIS as a high tech overhead projector from the “old days” that used
transparent plastic sheets and dry erase markers as inputs that were then projected on a wall.
If you think of each transparent sheet as a separate map layer, and you place all of the
transparent sheets (map layers) on top of each other, you can see through all of them at once.
In this way, you can see relationships among the data that overlap in certain areas. Essentially,
GIS does this in much more sophisticated ways.

Visualizing multiple map layers offers a means of exploring relationships among
different data variables. For example, a map that only shows burglary points and absolutely no
other data may not be particularly helpful. But, the burglary data can be layered with base map
data that displays the street network to show where these burglaries were committed. A third
layer could display all the properties across the area (e.g. owner occupied, rented, vacant
buildings). These three layers might suggest that burglary incidents are highest on side
streets—not major roadways—and in the areas where there is also a high percentage of vacant
properties.

GIS Components
A GIS has five components: hardware, software, people, data and storage:

The bare minimum for hardware is a computer. GIS hardware requirements might also
include peripherals such as a printer, plotter, or scanner. PDAs or GPS technology may also be
used to synchronize data captured in the field to a central database. Off the shelf GIS software
products possess a wide range of functionality; though, software extensions can be added for
advanced analysis and map production. Operating a GIS involves bringing together the
computer files that contain the data to be used, and possibly editing them, querying against
them, linking them, adding new data and generating a display for output. A GIS requires trained
people to perform these technical skills, as well as to ask spatial questions and interpret and
communicate findings. Data must have a geographic reference such as ZIP codes, street
addresses, or x,y coordinates that can be used to link it to a map. Data collected via Excel,
Access, Oracle, or any other type of spreadsheet or database management system has potential
for use in a GIS. Digital storage drives are also needed to keep large amounts of data.




What is GPS?*

Trying to figure out where you are is probably one of humankind's oldest problems.
Navigation and positioning are crucial to so many activities and yet the process has always been
guite cumbersome and inexact. Over the years all kinds of technologies have tried to simplify
the task but everyone has had some disadvantage. Finally, the U.S. Department of Defense
decided that the military had to have a precise form of worldwide positioning. The result is the
Global Positioning System, a system that's changed navigation forever.

The Global Positioning System (GPS) is a worldwide radio-navigation system formed
from a constellation of 24 satellites and their ground stations. GPS uses these "man-made
stars" as reference points to calculate positions accurate to a matter of meters. In fact, with
advanced forms of GPS you can make measurements to better than a centimeter! In a sense
it's like giving every square meter on the planet a unique address. GPS receivers have been
miniaturized to just a few integrated circuits and so are becoming very economical. And that
makes the technology accessible to virtually everyone. These days GPS is finding its way into
cars, boats, planes, construction equipment, movie making gear, farm machinery, even laptop
computers. Soon GPS will become almost as basic as the cell telephone. In fact, GPS technology
is being used now in cell phones to implement the emergency ('911') location system.

How GPS Works
Here's how GPS works in six logical steps:
1. The basis of GPS is "triangulation" from satellites. To "triangulate," a GPS receiver
measures distance using the travel time of radio signals.
2. To measure travel time, GPS needs very accurate timing.
3. Along with distance, you need to know exactly where the satellites are in space. High
orbits and careful monitoring are the secret.
4. You must correct for any delays the signal experiences as it travels through the
atmosphere.
5. Finally (for us), you can now obtain the precise time from the GPS satellites.

Improbable as it may seem, the whole idea behind GPS is to use satellites in space as reference

points for locations here on earth. That's right, by very, very accurately measuring our distance
from three satellites we can find our position anywhere on earth.

*This page was adapted from Todd Ensign’s article “Understanding GPS Terminology”
From www.beaglesoft.com/gpstechnology.htm
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What is a "GIS career"?

GIS careers exist in every imaginable discipline, from environmental science to mining to urban
planning to commercial businesses to defense and beyond. As a result, there is no one
definition of a career in GIS. A GIS career path has many origins, but there are some core skills
required. The broad range of GIS opportunities available gives you the ability to combine your
passions or interests with GIS for a satisfying and successful career.

What do GIS professionals do?

GIS professionals use GIS to visualize, analyze, and model systems to help in the planning and
decision-making processes of their organizations. They make geographic information accessible
to scientists, planners, decision makers, and the public.

GIS careers typically include positions such as

e Cartographic designer
e Computer programmer
¢ Database administrator
e Project manager

e System administrator

They also encompass business development, managerial, and administrative roles.

GIS is often associated with making maps, but GIS professionals do much more than that. GIS is
used to manage human activities. The ESRI Map Book Gallery illustrates through real-world
examples the range of topics, activities, and locales to which GIS can be applied.

GIS jobs range from part-time to full-time posts, and salary varies widely by region, nation,
discipline, and experience. Salary.com reports the range in the United States as between
$31,387 for an entry-level analyst to $83,333 for a GIS supervisor as of January 2006.

How are GIS professionals educated?

GIS professionals are educated in three main ways.

e Through special certificate programs at colleges and universities (most common)

e Through degree programs at colleges and universities

e As part of their curriculum in other specialties such as while pursuing an urban planning
degree
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Exploring NASA Centers

Lesson Overview:

Geography is defined as the study of the Earth and its lands, features, inhabitants, and
phenomena. It is important to know how the location of something influences people, the
environment, the economy, and how they are all connected. Geographic Information Systems
(GIS) can help decision makers choose the right locations for businesses, government agencies,
even satellite and space exploration mission launches. This lesson demonstrates how
geography influences where NASA Centers across the United States are located.

Skills:

1. Explore a GIS map and get information about map features

2. Use common tools (identify/zoom/zoom to full extent, clear selected features, zoom layer,
select features).

Access attribute table and look at its available features.

Change display properties, such as transparency, color, outline, label symbols.

Label features.

Create a layout.

ou kW

Standards Of Learning:

Virginia Standards of Learning: Earth Science (ES.3); World Geography (WG. 1); Computer
Technology (C/T8.1, C/T8.4)

National Science Standards: Content Standard A (Science as Inquiry); Content Standard D (Earth
and Space Science); Content Standard E (Science and Technology)

References:

Original lesson developed by Gregory Overkamp; Adapted by Wendy Stout. Extension activity
and experienced user activity developed by Lisa McCray.

Questions to be answered:

1. Which US states have NASA centers?

2. What geographic factors should NASA consider when choosing a location for a NASA
Center?

3. Why do you think the Kennedy Space Center is a good location for the Space Shuttle launch
pad?
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1. Start ArcMap

Double-click the ArcMap desktop shortcut icon or by clicking your Start menu, then
clicking Programs > ArcGIS > ArcMap.

Choose the option to start using ArcMap with an existing map and double-click
Browse for maps.

If you don't see the dialog, click the Open button =
Navigate to the Overspace\ExploreUSA\ folder on your flash drive.

Double-click USA.mxd to open the map document.

2. Adding and Preparing Data

+
Click on the Add Data icon |and go to the OverspaceData\ExploreUSA\USAData
folder.
Click on &l counties.shp . Click Add. You should now see the following after this layer
is added:

. Untitled - ArcMap - ArcViev =10 x|

Eile Edit Wiew Insert Selection Inols Window Help
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You now have a map that shows all the counties in the US. The colors may be different from

the colors in this picture.

3. Identify Features

Select the Identify icon E and click on an area of the US.

An Identify Results window pops up
which gives you information listed in the Layers: [<Topmost layer> =l
data table for that particular spot on the : 'L;?T;m ['?5'3“?533|35'2m1“‘
H- FID 1708
ma p . -- Suffolk. Shape Palygon
Scroll down through the data and see i STATE NAME Vigna
. . . . . 3 STATE_FIPS 51
what information is listed in the data table b renford CNTYFPS 093
o FIPS 51093
. H- hates AREA 321.6294
for that particular spot on the map. Sk o Mo s




We want to see the outlines of the states with the counties inside them.

e C(lose the Identify Results window.

e Turn off the Identify icon by clicking on the Select Elements icon k .
. Untitled - ArcMap - ArcYiew =10l x|
J File Edit Wiew Insert Selection Tools Window Help ‘
J DEE&E - @ % | o | & |[Finaso -”ﬁ|@a‘w|
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Contents with both *
shapefiles selected. m
d
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»
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3 .
o £y
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Display Selection iﬁ o2 4 | »|L
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[ [7zez'5e.60"w seeso0zIN | v

e C(lick on a blank section in the Table of Contents to deselect both shapefiles.
e C(lick on the states layer and drag and drop it above the counties layer. Notice how
the layer on top hides the layers below it, although bottom layers are still active.

4. Transparency
Now we will make the top layer semi-transparent so the counties layer will be visible on
our map and corresponding counties will appear within state boundaries.

e Make sure the states layer is selected and right-click on it and choose Properties.
e Inthe Layer Properties window, select the Display tab. Change the transparency to
60% and click OK.

Your map now shows the outline of the states with the counties layer showing through.
The outlines of the states are a little faint so we need to make them thicker.

5. Symbology

e Click on the small colored box below the
states layer in the table of contents. A
Symbol Selector box will open.

e Choose Hollow as the background color.
Change the outline width to 1.5 and the
outline color to black.

e Click OK.

Your map should now look like the map at right.
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6. Adding Imagery Data

Add ¥ the B LaunchComplex39.ipg file
Drag to the top of the table of contents

Note: for this file, you will have to highlight it and click Add rather than double
clicking on it. This file is an aerial photo of the launch complex at Kennedy Space
Center.

In the Table of Contents, right click [# LaunchComplex39.7pa and click Zoom to Layer.
This will fill your screen with the information in that file.

The Counties and States layers may be on top of the aerial photo. Turn these
layers off by removing the check mark next to them in the Table of Contents.
Notice that the boundaries of the Counties and States layers do not align with
the aerial photo. Why is that?

Layers can be turned on and off by the boxes next to them. When files are added to
your map they are automatically turned on.

7. Using Tools (Zoom, Pan, and Full Extent)

Launch Complex 39 is famous for its use in the Mercury, Gemini, and Apollo
programs as well as being the launch site for the space shuttle. Take a few
minutes to look at the area around the launch pads. .
Zoom into the aerial photo using the Zoom tool &
Position your magnifying glass cursor at the top left
corner of one of the launch sites and, while holding
down the left mouse button, draw a box around the
site. Your view will now be zoomed into the launch
site. You can move the image to see the surrounding
area by using the pan tool 7. You can go backto a
previous view by using the Previous Extent tool.
Look closely at the image and try to answer these
questions:

v" How many launch pads are there at Launch Complex 39?

v Describe the terrain that the Launch Complex was built in.

v" Rockets are launched in an eastward direction to take advantage of the
rotation of the earth to help them into orbit. Launching in a westward
direction requires much more energy. Knowing this and after examining
the terrain around the launch complex, can you explain why NASA chose
this location to launch from?

When you are done, return to the view of the United States by clicking the Full
Extent button @. We no longer need the aerial photo, so remove it from your
map by right-clicking on B LaunchComplex33.1p3 and clicking Remove.

Turn on the Counties and States layers.

v



8. Creating a Map of NASA Centers
Next we will create a map of the NASA centers throughout the country.
e First, select the Zoom tool ® and draw a box around the contiguous United
States.
e Add ¥ the ©masacentersiyr file. This file contains information about NASA centers.
Your map should now look similar to the one below:

aut

T

9. Exploring the Attribute Table

Layers in GIS have a table attached to them that provides additional information about the
layer. The NasaCenters attributes table contains the name of each center, an important
landmark, and the center’s location.

e Right-Click on the NasaCenters layer in the Table of Contents and click Open

Attributes Table.
e Look at the landmarks column.
v" Which state is the Hubble Space Telescope Operation Center located in?

e C(Close the attributes table when you are done viewing.

10. Labels

e Add labels to the centers by right clicking the ® ¥ Nasacenters jn the Table of Contents
and clicking Label Features. The NASA centers will now be labeled, but the labels
are difficult to read.

e Right-click ® ¥ HNasaCenters gnd click properties. Go to the Labels tab. Under the Text
Symbol section, change the font to size 9 and Bold. Click OK

The labels are a little easier to read, but the county lines make the map look cluttered.
e Click on the little box under the counties layer. The Symbol Selector window will
appear. Change the outline color to Gray 20%. Click OK.

11. Close ArcMap

e From the File menu, choose Exit. Click Yes when asked if you want to save changes.
e Save as nasa.mxd on your Flash Drive. Click OK.
Note: .mxd is the file extension for saved arcview map files.

.shp is the extension for shapefiles.

v



Exploring USA Data - Demographics Extension

1. Make a population map.
e Start a new blank map. (File>New)
o Add [Elcounties.shp from the OverspaceData\ExploreUSA\USAData folder.
e Right-click counties in the Table of Contents and click Properties.
e Click the Symbology tab.
e Select Quantities>Graduated Colors.
e Select POP2000 as the value.
e Select a color ramp that you like.
e Click OK.
Your map will now show population by county. ArcMap contains a mode called layout view
that helps you to create an attractive map for printing or sharing on the computer.

2. Use the layout view.

O View Insert Selection Tools Window Help
H H H b % I @ Data Frame 1164 v| 2 A @O K | qyar O states i

e C(lick on the small layout view icon at o D ?E " o pelemabe _Wp{mw—'
the bottom of your map. L ATe — s

w B Heatline...

e Go to Insert/Title on the menu bar. s @ Legend...
: @ North Arrow...

e Type in a title for your map. You may E:zzmu

_3“35 @ Picture...

s R

experiment with colors, etc, of the tile by

double clicking in the title box.

“REow

I, B
-

fll

Jaz
j%.

e Insert a compass rose (of your choice).
Insert/North Arrow.

e Insert the scale of your map. Options such as division units can be changed by
double clicking it.
e Insert/Legend. Use the Legend Wizard to set up your legend.

e You may experiment with inserting other map elements, such as a neatline or text.

e You may save this map as a jpeg for use in a PowerPoint or to print out.
e File/export map.

e Navigate to the folder you want to save it in.

e Give it atitle and save it in preferred format: jpeg, tiff, etc.




Exploring Virginia

Lesson Overview:
In this lesson students will explore the physiographic provinces and the major watersheds in

Virginia. They will map the natural resources. By doing so, students will develop a greater
awareness of their watershed and the natural resources available in Virginia.

SKills:

1. Define map properties (coordinate system/units/projection, relative path names)
2. Access attribute table and look at its available features

3. Use the query tool: select by attribute

4. Label features

5. Add imagery (raster)

6. Change symbology quantities

Standards Of Learning:

Virginia Standards of Learning: Life Sciences (LS.12); Earth Science (ES.1, ES.3, ES.9); Biology
(BlO.1, BI0.9); Computer Technology (C/T 8.1, C/T 8.4)

National Science Standards: Use technology to investigate and communicate, formulate and
revise models, human modifications of ecosystems.

References:
Lesson developed by Lisa McCray, adapted by Wendy Stout.

Questions to be answered:

1. How are the highest elevations in the state represented on the map? Where are the highest
and lowest places in Virginia?

What is the length of the Cowpasture River?

What watershed do you live in?

Which river is closest to your house?

vk wnwN

Which rivers are in your watershed?
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1. Using ArcCatolog

ArcCatalog is the ArcGIS application designed for browsing, managing, and documenting
geographic data. ArcCatalog and ArcMap work together. You can find and preview data in

ArcCatalog, then drag and drop the data into ArcMap to work with it.

The ArcCatalog interface consists of the Catalog tree on the left and a preview pane on the

right. You use the Catalog tree to navigate and browse data.

e Open ArcCatalog by clicking on the & icon on the menu bar.

Navigate to ExploreVirginia/VirginiaData.
oo __________________cex

© canm

>
<8

The preview pane in ArcCatalog has three tabs which provide different views of your data. The
Contents tab shows a list or thumbnail graphics of folders and files. The Metadata tab shows
information that has been documented for a dataset. The Preview tab shows the geographic

and tabular information for a dataset.

2. Metadata

Metadata is commonly called "data about data." More precisely, metadata is information that
describes, or documents, a geographic dataset. It typically includes information about why the
data was collected (its purpose), what geographic area the data covers (its geographic extent),

who collected the data, when the data was collected, what
processes were performed on the data, and who should be
contacted for more details about the data.

e Inthe Catalog tree in ArcCatalog, click cities, then click
the Metadata tab. Green text is clickable — clicking
green text displays or hides information about the data.

e Click the Attributes tab to see the total number of
records in this dataset.

e C(lick the attribute names and explore their definitions.
Look at the metadata for AREAWATER.

e Which city has the most water?
e What is the source for the AREAWATER data?

UU.S. Cities

Personal GeoDatabase Feature Class

Spatial | Attributes

Keywords
Theme: point, cities, capitals,
demographics, population, households,
location, society

e Click on the Description tab. Click the Publication Information.

e Locate the contact info for ESRI.




e Close ArcCatalog

3. Creating a New Map
e Click on ArcMap
e Select a new empty map
e Click OK for an empty map

4. Coordinate systems
Types of coordinate systems:

Coordinate systems (either geographic or projected) provide a framework for defining real-
world locations. In ArcGIS, the coordinate system is used as the method to automatically
integrate the geographic locations from different datasets into a common coordinate
framework for display and analysis. There are two common types of coordinate systems used in
GIS:

1. A global or spherical coordinate system such as latitude-longitude. These are often
referred to as geographic coordinate systems.

2. A projected coordinate system based on a map projection such as transverse Mercator,
Albers equal area, or Robinson, all of which (along with numerous other map projection
models) provide various mechanisms to project maps of the earth's spherical surface
onto a two-dimensional Cartesian coordinate plane. Projected coordinate systems are
sometimes referred to as map projections.

5. Set coordinate system for the map
e Right click on Layers click on Properties
e Select the Coordinate system tab

e Select predefined/geographic coordinate Data Frame Progariie el
Arotstion Growps | Extort Rectangles Frame | Site and Fosiion
SystemS/NOFth Amerlca/NOFth Amerlcan Datum Gonorel | DetaFrame  Coordnete Sytm | Muminsion | Grds Map Cacke |
1 9 8 3 i G:;_I:L:L:mﬂ:.:-_;;) [ Cloar

Note: If the layers don’t overlap properly, the
coordinate system of the two layers does not
match. Either set your coordinate system when you
begin a new map or check to make certain that
your data layers have the same coordinate system.




6. Adding Layers Using ArcCatalog

e Add vacounties.shp from ExploreVirginia/VirginiaData to the map.
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In the last lesson we added data to ArcMap using the Add Data button. You can also

add data by dragging and dropping data from ArcCatalog into ArcMap.

e Dragging and Dropping: In the Catalog tree in ArcCatalog, click and drag the
following layers into the map. Click OK to any warnings:

o

o
o
o
o
o

vacities

Lakes va
Physio

Va_elev
rivers_va
va_watersheds

e Layers are turned on when the small box in front of the name is checked. Practice
turning the layers on and off.

7. Attribute Table

e Make sure va_elev open its Attribute Table. (right-click>Open Attribute Table)

e Right-click on the heading gridcode and choose sort ascending. This rearranges the

records in the layer.

e Scroll down the table.

v" What is the range for the gridcode?
The gridcode represents elevation.
v' What gridcode represents the highest elevation? 1 or 7




8. Symbology

Turn off all layers except the va_elev layer.
Close the attribute table and right-click va_elev and select properties.
Click on the symbology tab

Under quantities, choose graduated colors  [eereme E2==)
Under fields, select grid code for the value %wmm le?‘m::rmglw ’
Change the classes to 7, choose a color h‘f:"*mm mm% e o [ 'l
ramp that goes from tan to dark blue called ||z ... =

partial spectrum. If you right-click on the lﬂK _

arrow next to Color Ramp and click on ﬁ J h

Graphic View, the colors will change to A S
words. ' — -

Click OK
v In what part of Virginia do you find the highest elevations? The lowest
elevations?
v" What is the elevation of the Atlantic Ocean? What is this commonly called?

9. Transparency

Turn on the physio layer and drag it above the elevation layer.
Right-click physio and go to Properties>Display Tab.
Change the transparency to 50%.
Click Apply, but not OK.
Move the properties box so you can see the map.

v" Which regions have the highest elevation? The lowest?
Select the labels tab on the properties box.
Check the Label features in this layer box.
Select province from the drop-down menu in the label field box.
Click OK.

v' Were your regions correct?

10. Play with Color

Turn off the physio and elev layers.

Turn on the vacounties layer. Change the color to green.

Click on the colored box under vacounties in the Table of Contents to get the symbol
selector. Choose yellow and change the outline width to 1. Click OK.




11. Select by Attributes and the Measure tool
e Turn on the rivers_va layer and make the rivers a dark blue.
e On the tool bar, select Selection/Select by Attributes. Make sure the layer is
rivers_va and method is Create a New Selection.
e Under Fields, double-click Name, single click on =, click Get Unique Values, and
double-click on ‘Cowpasture River’. Click OK. Cowpasture River is selected on the
map.

ST |

Tades Pt
Tt sherrany e’

SRR | e o

= ] < | °!J "Copper Cresk

~ — —— | Compastay Fevar'

x| Jo | (na] g
3| i |
SELECT * FROM hars v WHERE

ALIE™ = Compainre Ao

opw | vewy | b | wowi | Smm |

o | sev | o |

v" How long is the river as the crow flies (a straight line from source to mouth)?
e Right-click anywhere on the map and click Zoom to Selected Features.

i

e Click on the “measure” tool -==_,

e The measure box appears. Click on the down arrow icon, click on distance, click
miles.Change the distance measurement to Miles clicking on the first point you want
to measure from.

~ak B LH n |

e Kilometers
Tomamroans  Area v Meters
Decimeters
o N
'&‘ﬂmuwmmns Cell'ﬂllletﬂ'!
Millimeters

¥ Miles
Nautical Miles
Yards
Feet
. Inches

Decimal Degrees
Deg Min Sec

e Onthe map, click on one end of the river, then hold down the left mouse button and
drag to the other end.
v' What is the distance? (Look in the measure window to see the distance.)
e Click on “Zoom to Full Extent” ® to restore your map to its original scale. Unselect

the river by using the Clear Selected Features tool.




12. Labels
e Turn onva_watersheds. Make sure the other layers are off.
There are several ways to label these

Watersheds: Ganami | Sowce | Salaction | Divplny | Symboloay | Fisids | Duinion Dusey Labols | Joins & Ratstns |
Lot s
e Right-click on the layer name in the e =
Table of Contents, scroll down to and i
Tt Sting _
click Label Features. Turn them off :"’";W“ = =
the same way. oz ‘; e
H H Othes Optons. Pre-detned Label Shie
e Right-click on the layer name and go — | ==

down to properties. Select the |
labels tab. Check the box to label (=] o ) ow |
features in this layer. Method
should be “Label all the features the same way”, next to Label Field, select NAME.
Click OK.

v" Which rivers are in your watershed?

e Turn on the rivers layer and zoom in on one watershed. You may label the rivers or
use the identify tool.

e Turn on the elevation layer. Can you make o 2R
any comments about the relationship ! il E
between rivers, watersheds, and H EH O M
elevation? In order to see elevation better i Sy e i~
we will make the watershed layer Q D., Q ;] pee ML
transparent. Click on th lor b nder
sp ick on the color box und m m D ] —

va_watersheds to get the symbol selector. o i e e _ weseen |

. _goe | Eew |
Choose Hollow and make the outline 2. B[O . =

13. Imagery and another way to add data
Satellite imagery
e Click on the add data icon ¥ ‘
e Select the c321_halifax...tiff file and click Add.
e Zoom in on the satellite image. Make sure the rivers layer is on. Notice how the
rivers line up with the image.

Save your lesson and close ArcMap.

v



Exploring Virginia - Geography Extension

1. Census Data

e Right-click on vacounties.

e C(lick on the attribute table and scroll right to see the data available. Look at the
data for Roanoke.

Hint: You might want to sort the Name field to find Roanoke.

e Right click on the column heading Name. Use the slide to see the census data
included for Roanoke.

v" How many Hispanics?
v" How many 65 or older?

e Click on the box to the left of FID in line with Roanoke. The line with Roanoke
information should now be highlighted in blue. Move the attribute table so you can
see the map. Roanoke has been selected.

e Close the attribute table.

Go to the Menu bar to Selection and scroll down to clear selected features.

2. Query
Here’s another way to locate a county: :
Select By Attributes 12X
e On the tool bar, select Selection/Select by v Pvacomniies .
[~ Oy show selectable layers in e ket
Attribute. Make sure the layer is vacounties and i S =l
method is Create a New Selection. T e
e Under Fields, double-click Name, single click on =, e 4
click Get Unique Values, and double-click on S S T
. . : . . L | Lo | o | [onraor
Covington. Click OK. Covington is outlined on the [ 0 | v | [cogon 3
map. o et et
FHAME® = ‘Coningaan]
e Go to Selection/Clear Selected Features.
Use a query with other fields on the attribute table. e
e Activate the cities layer. Drag it on top if it is not ot ] v | com |

already there.

e Selection/Select by Attribute.

e This time make the query population “POP2000>=100000" (make sure the layer is
vacities). Click Apply.

e Addtothe query “and” “med_age” < 30.

v What are the results?



3. Exporting as a New Shapefile

Suppose the only cities we wanted to work with were the cities with a large population with a
median age less than 30. We can isolate it and save it as a separate shapefile. We will
accomplish this by performing the following steps:

You have already isolated (selected) the cities of interest in step 2. You can now
export them as a separate shapefile.

Right-click the vacities layer and select Data>Export Data...

You want to put your new file in a location that is easily found.

Browse to the ExploreVirginia folder in your flash drive and create a new folder.
Name it new data.

Open the data folder and click Save.

This should direct ArcGIS to save your new shape file in the new folder and will be
reflected in the “Output shapefile of feature class:" box.

Replace the default name (Export_Output.shp) with a name you choose for the new
shapefile, such as LargeCities.shp.

Click OK. You will be asked if you want to add the exported data to your map as a
new layer. Choose Yes.

Now let’s look at what you have created

Keep ArcMap open

Right-click on start at the bottom of your screen

Go to Explore

Find your NewData folder inside Exploring Virginia

Notice the number of files that have the name “LargeCities"
Close Explore and go back to ArcMap

You now have your new shapefile listed in the Table of Contents.

Deselect your selection on the vacities layer by clicking on Selection on the top
menu bar and choose Clear Selected Features.

Turn off the vacities layer and you will see only large cities displayed on your map.
Right-click on LargeCities in the Table of Contents and choose Zoom to Layer.

Your newly created shapefile is centered and enlarged.

Open the Attributes Table (right click on LargeCities layer and then Open Attributes
Table) and explore the data that you have in your new shapefile.

v



Now try selecting features manually by selecting the Select feature tool L | from the
standard toolbar. Hold down the shift key while selecting multiple cities and then follow the
steps above to create a new shapefile.

4. How to End
At this point, you have several options:

1. If thisis a project you want to save, or work on it without
having to add the layers, go to File/Document | B ammesine | e | |
Properties/Data Source Options and select “Store relative | |

path names to data sources”. This makes the file more T

transportable. Now do File/Save and put itin an . ' owssesopten |

appropriate folder.

2. If you want a picture of this map in JPEG format to import into a Word document or
PowerPoint, use File/Export Map and save as a JPEG file.

3. Or exit without saving.




Google Earth - Volcanoes

Lesson Overview:

In this lesson, students will use Google Earth to identify the type of several volcanoes, including
Tristan de Cunha in the South Atlantic, Mt Rainier in Washington, Lava Butte in Oregon, and
Olympus Mons on Mars. These volcanoes represent one of the three main types of volcanoes.
Each type has its own characteristics. Below is a table explaining the differences between the
three types of volcanoes:

Three Main Types of Volcanoes

The three main types of volcanoes differ in shape, size, and make-up; the differences partly result from the different types of

concave upward

eruptions.
V(;I;;go Volcano Shape Volcano Size Volcano Materials Eruption Type
™ Small
Cinder Cone \-x__ less than 300m cinders Explosive
Steep conical hill with stréight sides high
Shield R Large . .
Volcano || Very gentle slopes; convex upward (shaped like ||OVver 10s of kms fluid lava flows (basalt) Quiet
a warrior’s shield) acrass
/
4 \ LT numerous layers of lava and
Stratovolcano| j_,f’ 1-10 kmin pyro}(lzlastics Explosive
Gentle lower slopes, but steep upper slopes; diameter

Skills:

Table from the Utah Geological Survey - http://geology.utah.gov/utahgeo/geo/volcanoes/volcano_type.htm
Use the table above to determine the category that each volcano belongs to.

1. Locate volcanoes using geographic coordinates
2. Find height and width of volcanoes using tools in Google Earth

3. Analyze 3D models of terrain using vertical exaggeration

Standards:
Virginia Standards of Learning: Math (M6.2); Earth Science (ES.2, ES.3, ES.8, ES.11): World
Geography (WG. 1); Computer Technology (C/T8.1, C/T8.4)

National Science Standards: Content Standard A (Science as Inquiry); Content Standard D (Earth
and Space Science); Content Standard E (Science and Technology)

References:

Lesson developed by Wendy Stout, Andrea Geyer, and Daniel Fourquet.

Questions to be answered: Identify the type of the following volcanoes: Lava Butte, Mt

Rainier, Tristan de Cunha, Olympus Mons

v



http://www.pen.k12.va.us/go/Sols/sciencesecondary.pdf
http://www.nap.edu/html/nses/html/overview.html

1. Identify volcanoes in Google Earth
e Open Google Earth.

The following is a list of the volcanoes you will find and where they are located:

Volcano Name, -
. Coordinates
Location
Lava Butte, 43.917
Oregon -121.356
Mt Rainier, 46.851
Washington -121.758
Tristan de Cunha, -37.108
South Atlantic -12.275
¥ Search
The volcanoes can easily be found in Google Earth by FiyTo | FindBusinesses | Directions

searching for the coordinates in the Fly To box in the top
left hand side of the screen, as seen in the picture to the
right. (Don’t worry about “N” or “W” shown in the example

Fly to £.g., 37 25 19.1"M, 122 05’ 06"

[43.917 121,356 ~

in Google Earth.)

v' Why is there a negative sign in front of the longitude?

2. Identifying the Volcano in Google Earth
There are three properties that can be used to identify the type of volcano: height,
width, the height/width ratio. Repeat the following steps with all three volcanoes to
identify them. Use the table provided below to help:

e First, determine the height of the volcano. To do this,
find the elevation of the summit and the base, then
subtract.

e Hover the mouse over the rim of the crater and look at
the bottom of the screen to see the elevation in feet.

Note: make sure that terrain is turned on in the Layers box
on the left hand side of the screen. If it is turned off,
everything will be at an elevation of Oft.

e Do the same from the base of the volcano. Then subtract the two values to find the
height of the volcano.

e Next, find the diameter (width) of the volcano using the ruler tool.

e Using the ruler tool | E/, click on the base of the volcano, then click on the base
directly opposite, so that you draw a line across the volcano. The line should cross
the center of the crater.




The height/width ratio can be found by dividing the height by the diameter. A value of
1 means that the volcano is about as tall as it is wide. A number lower than 1 means the
volcano is wider than it is tall. A number above 1 means the volcano is taller than it is

wide.

Volcano Name

Height

Width H/W Ratio | Type of Volcano

Lava Butte

Mt Rainier

Tristan de Cunha

Olympus Mons

3. Vertical Exaggeration

If you are finding difficulty identifying the volcano type based on the information you
just collected, then it might be helpful to look at the 3D model of the volcano and
compare it to the profile picture in the table.

This view is similar to what the volcano would look like in real life. Sometimes it is
easier to see the details of features if you distort the surface. If the vertical scale is
larger than the horizontal scale, small differences in elevation become easier to see.
This is called vertical exaggeration because the vertical features are stretched so that
they’re easier to see.

For an example of vertical exaggeration, look at the drawings below. The first drawing
represents the profile of an island where the vertical scale and horizontal scale are the
same — the way it would look from a nearby boat. The second drawing represents the
profile of the same island where the vertical scale is greater than the horizontal scale.
As a result, differences in elevation are much clearer in the second drawing.

v



Profile of an island — no vertical exaggeration

Profile of the same island — with vertical exaggeration

The same concept can be used in Google Earth to help identify volcano types.

e In Google Earth, click Tools, Options...
e Inthe 3D tab, change the Elevation Exaggeration option to 2. Click OK.

The terrain around the volcano will now have vertical exaggeration.
Note: Holding the Shift key while you work the hand will allow you to “tilt” the image

e Try changing the Elevation Exaggeration to 3.
e When you are done, return the value to 1.

4. Panoramio Photos
Google Earth users are able to post georeferenced

associated with geographic coordinates) photos to Google | tavers
( g g p ) p g EY k= Primary Database
Earth through a website called panoramio.com. The VI Borders and Labels
. . Places of Interest
photos appear on the screen as a small picture icon 2 that 3 Panoramio Photos
E= Roads
you can click. You may need to turn on the Panoramio 30 Buildings
. .Q Ocean
Photos layer on to see them. Spend a couple minutes [ & street View

looking at pictures of the volcanoes that people posted.




5. Volcanoes on Mars

Volcanoes also occur on other planets. After you have identified the type of the first
three volcanoes, try identifying the type of the largest volcano in the solar system,
Olympus Mons.

e In Google Earth, click View, Explore, Mars.
e Enter the coordinates of Olympus Mons: 18.4 -134.0
e Take the same measurements of this volcano as you did on the Earth volcanoes.




Earthquakes and Volcanoes

Lesson Overview:

GIS can be used to investigate and visualize earthquake and volcano data by looking for
patterns and comparing events that took place at different times. By analyzing earthquakes and
volcanoes in this way, GIS offers a way to predict where increases in earthquakes may next
threaten populations.

SKkills:

1. Compare different map layers and identify relationships between them
2. Identify spatial patterns and give reasons to explain them

3. Change symbology for data layers: categories, group values

4. Open an attribute table for an active layer

5. Use a query to select features and records in a layer

6. Create and export new shapefiles

Standards:

Virginia Standards of Learning: Earth Science (ES.2, ES.3, ES.8, ES.11): World Geography (WG.
1); Computer Technology (C/T8.1, C/T8.4)

National Science Standards: Content Standard A (Science as Inquiry); Content Standard D (Earth
and Space Science); Content Standard E (Science and Technology)

References:
Lesson developed by: Gregory Overkamp; adapted by Wendy Stout.

Questions to be answered:

Where do most of the world’s earthquakes take place?

How can GIS data be used to plan for natural disasters?

What GIS data would be useful to assist officials in making decisions?

Which countries had the greatest number of people affected by Earthquakes/ Volcanoes?
What is the relationship between coastal plate boundaries and the concentration of
volcanoes and earthquakes on Earth?

ukwnN e



http://www.pen.k12.va.us/go/Sols/sciencesecondary.pdf
http://www.nap.edu/html/nses/html/overview.html

1. Add Data

Open ArcMap and start with a blank map.

. .+
Click on the Add Data icon and go
to the Earthquake_Volcano Data
folder. In this folder you will see the
following files:
0 Click on Ellentryoz.shp,
O  While holding down the ctrl key,
click on ElPiat_pol.shp 5,
= plates_4tvpes.shp

Click Add and OK to the warning
messages

x

Look in: I[:I Earthquake_Walcana Data j EI

= cnitry0z.shp

Add

Cancel |

Mame: ||

Show of type: IDatasEls and Layers [*.lyr] ﬂ

Notice how all shapefiles added are selected (in blue) and turned on (small boxes next
to shapefile name are checked) in the Table of Contents.

You now have a map that shows the world countries, crust plates, and plate boundaries.

2. Identify Results

Click on the Identify icon E and click on an area of the map. An Identify Results
window pops up which gives you information listed in the attribute table for that
particular spot on the map. Scroll down through the data and see what information
is listed.

Make sure the layer you want info on is selected.

The Identify Results window displays the information contained in the Attribute Table.

Close the Identify Results window. 2]
Turn off the Identify icon by clicking Idertiy from: [ <Top-most layer> =1

Lacation:

|-1.13?931 -30,155172 Decimal Degrees o

=- F'.Iat_pol
on the Select Elements icon k ) - African Plate
Field | ‘alue

FID 10

Shape Folygon
PLATES_ID &

PLATE African Plate




3. Working with Layers

Turn off all layers except the cntry02 layer. Click the small box next to the shapefiles
you want turned off (this will uncheck the box) and leave the cntry02 layer turned
on.

Click on a blank section in the Table of Contents to deselect all the shapefiles.

Your map should now show only the world PAR8 ver o ST Dueeny
countries. o o
- .5 s
® N Y
4. Symbology i B
o S +
e Change the color of the world countries by N i
clicking on the small colored box below the e el S asiuA

Your map now shows earthquake and volcano data
around the world. This appears very congested so let’s . T —
turn off the volcanoes layer and make the symbols for
earthquakes smaller.

shapefile you want to work with. Clicking the small box below a layer will enable you
to manipulate symbol styles, colors, sizes, etc.

A Symbol Selector box will open. Click on the color you want features in your
shapefile displayed.

Features can be outlined in different colors and different widths.

Open the Outline Color box and choose No Color. Click OK.

alx]

Gl | Sowse | Selection | Display  Spebobogy | Fiekds | Diefintion Qusy | Labels | Joins & Rstsis |
o Dt all Imslins szing the e symbol. |

Catngoties et

Quanities =
Chaite & _tued <

Foatures

Double click on the quakes layer and a Layer
Properties window pops up. Click on the Symbology
tab.

Single symbols can be selected by clicking on the Symbol button.

A symbol selector window pops up in which you can click on any symbol you want.
Select a symbol and adjust the size and color you want.

More symbols are available and are grouped by category. Click the More Symbols
button and select the category you want. The symbols will be added to the end of the
current symbols display.

Click OK.

Your map now has earthquakes displayed using the symbol you chose.

v



e Turn on the volcanoes shapefile (check box next to shapefile name in Table of
Contents) and select a size and color you want them displayed in. After selecting the
symbology for volcanoes your map will look something like this:

5. Select by Attribute

= Untitled - ArcMap - ArcEditor,

File Edit Wiew Bockmarks Insert Selection Tools Window Help

Edm-‘ 3 | # ~ Tk [Create New Feature | | Targst: | | |X &) ‘ | ‘

DEES|: EaX e b el R EEEEE

= £ Layers
=] QUIAKE:
.

= B OLCAND
.
= O plates_dtypes
= B cuTRYDZ
|

= O Plat_pol
O

isplay | Source | Selection jam e 4 IE
gown [k & 8|0~ Al| 22 [ ElEER N SEAP ]

| |-188.867 109.275 Decimal Degress

Let’s identify earthquakes that have a magnitude of 7.0 or greater on the Richter Scale.

e Inthe menu bar, click Selection, Select by Attribute

e Change Layer to quake.

e Change Method to “Create a new selection.”

e The large box on top lists all of the fields of the quake layer. Double click on “MAG”.
The “MAG” attribute will be added to the query box on the bottom.

e C(lick the >= sign button.

We want to list all the choices

possible for the field we are working
with (in this case, magnitudes of
earthquakes in our data set).

e Click on the Get Unique Values

box.

Notice how all the possible choices
pop up in the large middle box.

e Select the number 7 by double-

clicking on it.

e Execute the query by clicking OK. After completing a successful query you will find
the results highlighted (selected) in a light blue color on your map, as shown:

v



6. Exporting Data

Now that your desired data is isolated (selected) you can export it as a separate
shapefile.

Right-click on the quake layer in the Table of Contents, select Data, then Export
Data.

Chose a location to save your file on your flash drive and name your new shapefile
Strong_quakes.shp. Use the following figure as a reference, then click OK:

2]
Export: ISeIected features LI

Ilze the zame coordinate system as:
i+ thiz layer's source data
" the data frame

{7 the feature dataset pou export the datainto
[only applies if vou expart ta)a feature dataset ina geodatabasze]

Dutput shapefile or feature class:

IC:\alcgis\.GlS OwerspacetGlS DatatUSAData Strong guakes. shp @I

QK I Cancel I

When you click OK, you will be asked if you want to add the exported data to your
map as a new layer. Choose Yes. Click OK to any messages that pop up.

Deselect your selection on the quake layer by clicking on Selection on the top menu
bar and choose Clear Selected Features. Alternatively, you can click the ® putton
in the tools window.

Turn off the quake layer and you will see only earthquakes with a magnitude of >= 7
displayed in your map.

Right-click on Strong_quakes in the Table of Contents and choose Zoom to Layer.
Your newly created shapefile is centered and enlarged.

Open the Attributes Table (right click on the Strong_quake layer and click Open
Attributes Table) and explore the data that you have for these earthquakes in your
new shapefile.

L=

FID Shape * DATE_ LAT LON DEPTH | MAG

3 0] Poirt 20000108 | -16.925| -174.248 183.4 7.2

1 |Poirt 20000225 | -19.528| 173818 33 71

2 |Pairt 20000328 | 22338 14373 1265 78

3 |Paint 20000423 | -28307 -62.99 608.5 7

4 |Poirt 20000504 [ 1105 123573 26 75

5 |Poirt 20000512 | -23.548 -6 452 225 72

6 |Paint 20000604 | -4721| 102087 33| 78

7 |Paint 20000618 | -13.802 97 453 10| 7.8

& |Poirt 20000806 | 28856 139556 394 8 73

9 |Pairt 20001116 -3958| 152.268 33 g

10 |Point 20001116 | -5479| 153.054 33| 78

11 |Poirit 20001117 | -5453| 151685 33| 76

12 |Poirt 20001206 | 38625 54 772 30 7
Record: ﬂjl 1 jﬂ Show: W Selected | cords ﬂ




e You can sort the data in the Attribute table. Put your cursor on the column header
MAG and right click. Choose Sort Ascending. Notice how the records are sorted
from lowest to highest magnitude earthquakes. Try it on the Date_ field.

7. More Symbology

e Turn the quake and VOLCANO layers back on and zoom in on the area of the world
with the most earthquake activity using the zoom tool.

e Turn onthe plates 4types layer to display the plate boundaries on your map. They
all look the same, so let’s categorize them with unique colors so we can see which
types are associated with the most activity.

e Double-click the plates_4types layer in the Table of Contents and the Layer
Properties window will pop up. Click on the Symbology tab and select
Categories>Unique Values.

e Change the Value Field to TYPE and click on Add All Values. Click OK.

Your map should now show the different types of plate boundaries by color, as shown in
the figure.

File Edt Wiew Bookmarks [nsert Selection Tooks Window Help
Edtor v | b | # = Task: [Create NewFeatue = | terget | B EeH=]]=] ‘
DSE& 4 B@% |0~ || BN EL A E R

—r

.

= 4 Quake
.

= M voLCANO

.
= plates_dtypes
— <all other valu

~ Ridge
Transform
= M CuTRVOZ
[}
= O Flat_pol

S

A~ [ a <[~ Blg‘iv&viv;-‘

| 127,286 -25.622 Decimal Degrees A

chior
fo-

We can see that most earthquakes and volcanoes occur near convergent boundaries.
Let’s make this even more obvious by making the convergent boundary lines thicker.

e Left-click on the line next to Converging in the Table of Contents and the Symbol
Selector window will appear.
e Change the width to 2 and click OK.

e Click the Full Extent tool 0 to show the worldwide view.

v



8. Labeling the Plates
Make the Plat_pol layer active and click on the square below it to change the color

of the plates layer.
e Choose a blue color and click OK.
e To label the plates, right-click on the Plat_pol layer in the Table of Contents and

select Label Features.

Your map is now complete. Try zooming in on different spots on your map.

v" Which plate contains the greatest number of earthquakes?




Hurricanes

Lesson Overview:

In 2005, Hurricane Katrina hit the Gulf and Atlantic coasts destroying homes, businesses,
infrastructure, and natural resources. In the aftermath, federal, state, and local governments,
service agencies, and the private sector responded to help rebuild. GIS aided critical tasks
including assessing the damage, monitoring the weather, coordinating relief efforts, and
tracking health hazards. GIS specialists provided relevant and readily available data, maps, and
images to the responders in the field. In this module, you will map the path of the hurricane
and understand how data helped federal officials decide where to allocate disaster aid in the
counties most affected by Hurricane Katrina.

Skills:

1. ldentify the path of Hurricane Katrina

2. Interpret thematic maps to answer questions and draw conclusions
3. Change symbology for data layers: categories, group values

4. Change display properties

5. Use analysis tools (buffer, clip) to find answers and make decisions
6. Interpret wind speed data using graphs

Standards Of Learning:
Virginia Standards of Learning: Earth Science (ES.3, ES.13); World Geography (WG.1, WG.2);
Computer Technology (C/T8.1, C/T8.4)

National Science Standards: Content Standard A (Science as Inquiry); Content Standard D (Earth
and Space Science); Content Standard E (Science and Technology)

References:
Lesson developed by Gregory Overkamp; adapted by Wendy Stout. Extension activities and
experience user lesson developed by Lisa McCray and Wendy Stout.

Questions to be answered:

1. What geographic area was impacted?

2. How can GIS data be used in emergency response decisions?

3. Which counties had the greatest number of people that were affected?

4. What additional data layers would you add to your map to help you to provide information
to aid in the decision-making process?

v


http://www.pen.k12.va.us/go/Sols/sciencesecondary.pdf
http://www.nap.edu/html/nses/html/overview.html

1. Add Data
e Open ArcMap.
e Select a new empty map.
e C(lick OK for an empty map.

| "

e Click on the Add Data icon
OverspaceData/Hurricanes/HurricaneData folder.

e Click on Ellcountry.she and, while holding down the ctrl key, click on Ell states.shp and
[E] katrina.shp |

e Click Add.

You should now see the following after those three layers are added (your default colors

and go to the

may be different):
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You now have a map that shows the world countries and the path of Hurricane Katrina.
The states layer is not visible because the country layer is on top and masking it.

e Deselect all layers by clicking on a blank spot in the Table of Contents and drag the
country layer below the states layer. You will see the US States displayed on your
map.

e (lick the Identify icon E and click on different features of the map to see what
data is listed for the different layers.
e C(Close the Identify Results window.

e Turn off the Identify icon by clicking on the Select Elements icon k .
e Change the colors of the world countries to beige and the states layer to olive.
Make the outline width .40 and the outline color black.




2. Symbolize the Path and Strength of Hurricane Katrina

e Right-click on the Katrina layer, click Properties, then click Categories under the
Symbology tab. Select Unique Values since we want the different stages of the
hurricane to be displayed in unique colors.

e The Value Field should be changed to the feature you are working with. In this case,
it should be status.

e Click Add All Values to add all of the attributes (hurricane strengths).

e Click OK. The stages of Hurricane Katrina now display in color:
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To make decisions about the impact of Hurricane Katrina, it is useful to reduce the
number of groups. Let’s group the storms strength into four groups; tropical
depressions and storms, weak, intermediate, and strong hurricanes.

e Go back into Layer Properties in the Symbology tab.

e While holding the Ctrl key, select tropical depressions and tropical storms.

e Right-clicking on either while they are selected will bring up a menu. Select Group
Values as shown in the following diagram.

Attributes can be grouped together and displayed on a map as one class.
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Group the HURRICANE-1 and HURRICANE-2 together and the HURRICANE-3 and
HURRICANE-4 together. Leave HURRICANE-5 alone.

Move the Tropical Depression
group to the top of the list by
highlighting it and clicking the

up arrow ﬂ

Change the sizes of the symbols
as follows: Make the sizes 4, 6,
8, and 10 respectively. Make
the colors as shown at right.
Click OK and your map should
look like the one below.
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3. Buffer
In the case of a hurricane, it is helpful to identify an area within a 100 mile distance from
the path so preparation, rescue, and relief plans can be made. To do this, we will need to
identify an area within proximity of another feature, the hurricanes. We can accomplish
this by creating a buffer. A buffer in GIS is a zone around a map feature measured in units of
distance.

e Click on the ArcToolbox icon B near the top of the display window. Select
Analysis Tools, Proximity, and then double-click on Buffer. A buffer window will
appear.

e The Input Features are what you want to buffer around. This should be Katrina.

e The Output Feature Class will be the name of the buffered shapefile you want
saved. Name the new shapefile and save it in your Hurricanes folder.

e Make the linear unit 100. Select Miles as the unit.

e We want to dissolve individual buffers around each point on our hurricane path, so
choose ALL for Dissolve Type.

e The Buffer window should look like the figure below. Click OK. Ignore the datum
conflict that you get.

.o
P —————
Input Features
Ikatrina j ﬂ
Qutput Feature Class
I C:\Documents and SettingsiGREGORY, OVERKAMPYOverSpace|YorkCDiBlowing Throughide ﬂ
Distance [value or Field]
& Linear unit
[ 100 [ies =l
" Field
| K
Side Type (optional)
fFuLL =
End Type (optional)
[OLND Fl e
Dissalve Type (optional)
7
Dissolve Field(s) {optional)
Oro
OLat
M ann j

Notice that the buffer is a separate shapefile and is added to the Table of Contents. It
does not include the data points for the hurricane. Turn the Katrina layer off and you
will see the buffer alone.




4. Clip

The clip tool extracts any features that are entirely within the boundaries that are defined.
Clipping works much like a cookie cutter.

Add Data E the Ell counties.shp and
drag it in the Table of Contents below
the B katrina_Buffer |ayer. We want
to see the counties below the buffer
so we will make the buffer somewhat
transparent.

Double-click on = M katrina_Buffer gnd
the Layer Properties window pops up.
Select the Display tab and change the
transparency to 60.

Click OK. You can now see the counties below the hurricane buffer.

We are concerned only with the counties that are within the buffered area of the
hurricane’s path, so we will separate them from the rest by Clipping.

Open ArcToolbox @ ifitisn’t already open and select Analysis Tools, Extract, and
then double-click on Clip. A Clip window will pop up.

The Input features is the layer you want clipped. In our case, we want the counties
within the buffered area separated from the others. Enter counties.

The Clip Features is the layer you want clipped to. In our case we want the counties
within the buffered area clipped to the buffered area. Select your buffer shapefile.
The Output Feature Class is the default name ArcMap gives to the shapefile to be
created. Accept the default name for this exercise.

Click OK. Close ArcToolbox & by clicking the X in the top right corner.

Turn off the Bl [ counties |ayer and you can see your clipped shapefile.




Right-click on = b4 & and select Open Attribute Table. The Attribute Table
lists all the counties that fall within the buffered area of the Katrina path. Using the
data in the table we can determine how many people will be most affected by the
storm.

The Attributes Table can be sorted in various ways by placing the cursor above the
column to sort and right-clicking. Sort Descending the column for the STATE_NAME
and scroll down to Louisiana to see the population data for the counties most
affected by Katrina. Do the same for Mississippi.
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5. Create a graph to show the wind speed of Katrina over time.

Go to Tools/Graph/Create

Select vertical line graph

Make sure that Katrina is the layer
Y field is Wind

X field is Time

Uncheck Add to Legend

* Create Graph Wizard
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Add X/Y Data Hurricane Extension

1. Adding X/Y Data [ Add xv Data ? [ |
° Open a neW map. ﬁ;:b;asgn‘r;y?mg)(andY::nmd\naledatacanbaaddedmtha
. . Choose a table from the map or browse for another table:
e Add the States and Counties layers from the hurricane | e = B
d f Id [~ Specify the fields for the X and Y coordinates:
ata 0 er. X Field: [Longtude |
e To add Hurricane Fred data, click Tools/Add X/Y Data v (e El
. i Coordinate System of Input Coordinates ————————————————
e Browse to Hurricane Fred folder —

Unknown Coordinate System

e C(lick on the excel spreadsheet and Add
e C(lick on Sheetl and Add
e The X field should be longitude

b

e TheY field should be latitude I Show e o
° C||Ck OK to a“ messages [ Wam me ff the resuling layer will have restricted functionalty
oK Cancel

2. Exporting a Shapefile
The path of Hurricane Fred is now shown on your map, but in its current form its use is
limited. It must be exported as a shapefile.
Right-click on Sheet1Sevents, Choose Data, Choose Export Data
Navigate to the Hurricane Fred folder
Name the file Fred.shp
Click OK
e Symbolize the track by wind speed using quantities/graduated symbols
(Hint: right-click on Fred and click Properties).
v" OOPS! Where is that extraneous point coming from?

= Select the point in Sudan, Africa using the Select Features tool L .

* Open the attribute table of = and compare the data of the selected point to
the rest of the points.
v" Can you find out what went wrong?

Solution: Notice that the longitude value of all of the points are negative (indicating that
they are located in the western hemisphere) except for the selected point.




Use the Internet to get Hurricane Data Extension

1. Get Hurricane Isabel Data from the Internet

Now locate Hurricane Isabel data from the NOAA website in a table format and display it in
ArcMap. Some basic knowledge of the use of Microsoft Excel is helpful for this section.
e Go to www.nhc.noaa.gov.
e On the navigation bar on the left hand side of the website, click on Seasons Archive
under the Hurricane History section.
e Inthe middle of the page, there is a section
that says Atlantic, Caribbean, and the Gulf o 1ot vt Huricans o .19 agarvor 20
of Mexico. Choose the 2003 season and mlftil"’m Hine Spesd
click Go. I
e Click Hurricane Isabel : ii
e About a quarter of the way down the page, H -
there is a table that shows information [l 144
about the hurricane, such as its location,
pressure, and wind speed. Highlight and copy it (Ctrl + C).

hurricane

Before we can import the data to ArcMap, we must put it into a format that it will
recognize. This will be a slightly complicated task. The easiest way to do this is to turn it
into an Excel file. We cannot simply paste the table into Excel because it will recognize
the numbers as text. The way around this is to first paste the table in Notepad, then
import it into Excel.

2. Using Excel for Data

e Open Notepad (Start>All Programs>Accessories>Notepad) and click Edit>Paste.

e Save the file as Isabel.txt.

e Open Microsoft Excel. And click Open. Change Files of Type to Text Files. Open
Isabel.txt.

e The Text Import Wizard window will pop up. Under Original data type, choose
Delimited. Click Next.

e Under Delimiters, check the box that says Space.

This section lets Excel know where one cell ends and the next begins. Every time there
is a space in the numbers, Excel will put the next set of numbers in the next cell.
Nothing needs to be changed in step 3 of the wizard.

e Click Finish.

The result will not look very pretty. It will need to be cleaned up before it is useful to us.



http://www.nhc.noaa.gov/

Date/Time
{uTC) Position  Pressure

{mhb) ind Speed
(kt) Stage
Lat.
{-N} Lon.
-w)
6/ o 13.8 314 1009 30 tropical  depression
6/ 600 13.8 32.7 1005 35 tropical  storm
6/ 1200 13.6 339 1003 an
6/ 1800 13.4 349 1000 45

7 n 125 a5 8 aan 55

e Perform the following steps to set up the data: Delete rows 1-7 and 65. (Be careful.
Select and delete all of these at the same time by using the Ctrl key. If you delete
them one at a time, the numbers or letters will change) Delete columns A, C, and I-
N. Insert a line above row 1 to create new headings for each column. The headings

should be as follows: Date, Time, Lat, Lon,

. Date Time Lat Lon LonwW Pressure Wind

Pressure, Wind. 6 0 13.8 314 314 1009

6 600 13.9 32.7 -32.7 1005

e Remember that the Lon values must be s 1m0 135 s s 1003

. . 6 1800 134 34.9 -34.9 1000

negative to show that they are in the western 7 o 15 w8 ss om

. 7 600 13.9 36.5 -36.5 991

hemisphere. Insert a new column between Lon 7 0 wa w3 a3 8w

. 7 1800 15.2. 38.5 -38.5 984

and Pressure and call it LonW. In cell E1 (the s o 8 w7 7 9%

first row in the LonW column), type in the T B B B

.f._- D []2 8 1800 17.6. 43.1 -43.1 952

formula - O_D2 == . 9 0 18.2 44.1 -4A.1 948

9 600 18.9 45.2 -45.2 948

1 1 9 1200 19.4 46.3 -46.3 948

e Copy the value of E2. Highlight cells E3 to E60 T e

H 10 0 20.5 48.3 -48.3 952

and CIICk PaSte. 10 600 20.9 49.4 -49.4 952

e Your table should now look like the figure at 0] w00] 211 sos -S04 a8

10 1800 21.1 514 -51.4 942

right' 11 0 21.2 52.3 -52.3 935

11 600 21.3 53.2 -53.2 935

e Save the table as an Excel Workbook. You may W w0l na  ose e 9

. L. . 11 1800 21.5 54.8 -54.8 915

now import it in the same way as you imported 1z o ms  ss7 557 9w
the Hurricane Fred data above.

30

40

55
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70
30

110
110
115
115
115
115
110
110
115
120
125
125
135
145
140

(Note, make sure you use the LonW data for longitude rather than the Lon data)
e Set Coordinate System
v" Can you find a relationship between the pressure and the wind speed?

Drill for Skill

Create a new map that shows a 100 mile buffer around Hurricane Isabel.
v" How many Virginia counties are within the 100 mile buffer?




Hurricanes Extension for Experienced Users

1. Perform the following tasks to complete this assignment:
Use the data in the “hurricanes” folder to create this map:

& Untitled - ArcMap

- ArcView

Eile Edit ¥ew Insert Selection Tools Window Help

DEEEEEEE T =l

D@ A& 4 BB X | o | & [ms v|£‘@%l§l‘k‘?‘
Bl o B
B £F Layers ‘, =

= @ .

Status

E & states
O

=] country
O

@ zall other values>

o TROPICAL DEPRESSION; TROPICAL STORM
@ HURRICANE-1; HURRICANE-2
3 HURRICANE-3; HURRICANE-4
@ HURRICANE-S

1

cBer ORI te s OH

<
Display | Source | Selection

z
' : =
Jam 2 4 |

J Drawing * R (=) |gj ﬁj i “pﬂﬂAna\

St = w7 u|Av B g oo

mstart| 0] Hurricanes - Mi... | 1 untitled - Paint | Hurricanes Dat. . ||@ Untitled - Arc..  [3) |m5;g,g& 2oz B serem

e Group the storms into four groups: tropical depression and storms; weak

(categories 1 and 2), intermediate (categories 3 and 4); and strong (category 5).

e Change the symbols of the new categories to create the following map:
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e Create a 100mi buffer around the path of Katrina. Save it in your hurricane

folder.

e Create a new layer that includes the counties in that buffer zone. (Hint: Clip)




e Which two counties were most affected by Katrina in Louisiana? In Mississippi?

e Create a graph of wind speed/time for Hurricane Katrina.

Graph of Katrina
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Remote Sensing Overview

Aerial photography was the beginning of being able to get images of
large areas of our planet. The use of satellites has drastically improved
that task. At the same time, a pixel (picture element) in the satellite
image covers a large area (e.g. 170 km x 185 km for the whole image)
and therefore is considered lower resolution than most aerial photos.
In addition, most satellite images use multiple sensors and therefore
you are able to put together many different images of the same area.
Those different images give us different information about the area
you might want to study.

For our purposes, we will use images from the Landsat program as "
representative of this technology. The program has been around since 1971 and has used
many different satellites. Landsat 5 has been the most prolific, by collecting images for more

than 25 years. In addition, each satellite returns to any point on the earth approximately each
16 days
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Light can interact with objects in different ways depending on the wavelength of the light and
the properties of the object. Objects can interact with light in three different ways: the light can
be reflected by the object, it can move through the object, or it can be absorbed. The following
graph shows which wavelengths are transmitted (move through) and which are blocked by the
earth's atmosphere. Notice that the visible wavelengths (what you can see with your eyes)
makes up a small portion of the graph.
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The next graph shows which wavelengths are important for viewing different objects. Notice
that you would use different combinations of Landsat bands to certain types of objects due to
these wavelength "signatures."
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The following list describes the wavelengths used by seven different sensors on Landsat 5.
Notice that they fit in the windows of "light" that can go through the atmosphere.

Band 1 (0.45-0.52 um, blue-green): Since this short wavelength of light penetrates better than
the other bands it is often the band of choice for aquatic ecosystems. It is used to monitor
sediment in water, mapping coral reefs, and water depth. Unfortunately this is the noisiest of
the Landsat bands since short wavelength blue light is scattered more than the other bands. For
this reason it is rarely used for "pretty picture" type images.

Band 2 (0.52-0.60 um, green): This has similar qualities to band 1 but not as extreme. The band
was selected because it matches the wavelength for the green we see when looking at
vegetation.

Band 3 (0.63-0.69 um, red): Since vegetation absorbs nearly all red light (it is sometimes called
the chlorophyll absorption band) this band can be useful for distinguishing between vegetation
and soil and in monitoring vegetation health.

Band 4 (0.76-0.90 um, near infrared): Since water absorbs nearly all light at this wavelength
water bodies appear very dark. This contrasts with bright reflectance for soil and vegetation so
it is a good band for defining the water/land interface.

Band 5 (1.55-1.75 um, mid-infrared): This band is very sensitive to moisture and is therefore
used to monitor vegetation and soil moisture. It is also good at differentiating between clouds
and snow.

Band 6 (10.40-12.50 um, thermal infrared): This is a thermal band, which means it can be used
to measure surface temperature. This is primarily used for geological applications but it is




sometime used to measure plant heat stress. This is also used to differentiate clouds from
bright soils since clouds tend to be very cold. One other difference between this band and the
other multispectral ETM bands is that the resolution is half of the other bands (60 m instead of
30 m).

Band 7 (2.08-2.35 um mid-infrared): This band is also used for vegetation moisture although
generally band 5 is preferred for that application, as well as for soil and geology mapping.

To create an image on your computer screen you are using combinations of red, green, and
blue. Therefore to create a normal looking (true color) picture you would choose bands

3, 2, 1. Because vegetation is more “visible” in band 4 (NIR), many people will use bands 4, 2, 1.
As an alternative, most vegetation is green and some people will do 3, 4, 1. The following
images are good examples of those combinations.

Hue, Vietham
23 April, 2003

Landsat image

Using the Band Combination Tool
http://biodiversityinformatics.amnh.org/to
ol.php?content id=141

bands 3, 2, 1

true color

This and the next two images are taken
from American Museum of Natural
History, Center for Biodiversity and
Conservation. Available from
http://biodiversityinformatics.amnh.org.
They are used under the Creative
Common license.



http://biodiversityinformatics.amnh.org/tool.php?content_id=141
http://biodiversityinformatics.amnh.org/tool.php?content_id=141
http://biodiversityinformatics.amnh.org/

bands 4, 2,1

Note that in this false color image, band 4
(near infrared) is represented in red.
Remember that vegetation strongly reflects
near infrared light. As a result, vegetation
in this image appears as bright red.

bands 3,4, 1

false color, but many may think it is true

bands 4,5, 7



Bands 3,4, 1

Landsat image of Roanoke, VA

Done by author to help identify tree canopy
within the city. Some additional band math
was done to create this particular image.

Resources:

Landsat images: glovis. usgs.gov
Remote Sensing Tutorial , http://rst.gsfc.nasa.gov/

http://biodiversityinformatics.amnh.org.

Canadian Remote Sensing Tutorial, http://www.ccrs.nrcan.gc.ca/index_e.php


http://biodiversityinformatics.amnh.org/

Remote Sensing in GIS

Lesson Overview
In this lesson, students will learn to download Landsat images from the USGS Global
Visualization Viewer and import the images into ArcMap.

Skills:

1. Use the USGS Global Visualization Viewer.
2. Find and download Landsat images.

3. Decompress images.

4. Import Landsat images into ArcMap.

Standards:
Virginia Standards of Learning: Earth Science (ES3); Physical Science (PS9);.World Geography:
(WG1)

References:
Lisa McCray and Heather Smith

Questions to be answered:

1. What services does GLOVIS provide?
2. What is Landsat?
3. How are Landsat images imported into ArcMap?




“The Landsat Program is a series of Earth-observing satellite missions jointly managed
by NASA and the U.S. Geological Survey. Since 1972, Landsat satellites have collected
information about Earth from space. This science, known as remote sensing, has matured
with the Landsat Program.

Landsat satellites have taken specialized digital photographs of Earth’s continents and
surrounding coastal regions for over three decades, enabling people to study many
aspects of our planet and to evaluate the dynamic changes caused by both natural
processes and human practices.”

http://landsat.gsfc.nasa.gov/

1. Using the Global Visualization Viewer

e Inaweb browser, go to glovis.usgs.gov. This will take you to a site that gives you
access to remote sensing images from many different satellites.

e The glovis home page features a large world map. If you know the coordinates of
the area you would like to download, you may enter them in the latitude and
longitude boxes above the map. Alternatively, you can click the area directly on
the map.

e After you have entered your request, a new java window will open showing a
small preview of the landsat images available for the area.

8OO USGS Global Visualization Viewer
Collection Resolution Map Layers Tools File Help

Downloadable

WRS-2
Path /Row:

Lat/ —~Go=
Long: 375 -804 ([ Go )

1734 (G0 )

Max Cloud: il

(100% 2) =) (=)
4

Scene Information:

ID: LT50170342010101EDCO0

Cloud Cover: 0% Qlty: 9

Date: 2010/4/11

[Aor B89 (2010 &4 (Go )
" Prevscene ) [ NextScene
( PrevScene | [ NextScene )

Landsat 4-5 TM Scene List

( ) ) ownl
( Add ) Del Sub Downl

1000m  No Limits Set

FYI: Landsat 7 has had image problems since 2003. You might appreciate using images from
Landsat 5 since it has been collecting images for 25 years. That provides you with images over a
wide variety of time to look at land use changes over time. The satellite returns to the same site
every 16 days

The glovis viewer displays important information about the selected image on the left hand side

v


http://landsat.gsfc.nasa.gov/
http://glovis.usgs.gov/

Richmond is in the center image that is identified as Path 15 Row 34
Scene Information shows that this image has no cloud cover (quality 9) and date of

image

2. Downloading Landsat Images
In the top of the window, the label DOWNLOADABLE indicates that the image is

immediately.

At the bottom left, click on the ADD button to the image to the window just above
the ADD button. That will then activate the Download button. ( If the image does not
have the DOWNLOADABLE label, then you will have

to click on the Sub(mit) button. This will start the
process for the getting the image available for
downloading.

™ 7 Confirm Download At No Charge

A small window will appear when you download an
image. (Shown below) The file name tells you that

it is a Landsat 5 image of path 17 row 34 on day
101 (April 11) of year 2010. The file is 156 MB.
You will need to create an account if you don't
already have one.

@

Scene: LT50170342010101EDCO0O
Product size: 156.6 MB

File format: compressed GeoTIFF
Estimated download time:

51.4 Minutes @ 512 Kbps

8.9 Hours @ 56 Kbps

Do you want to continue?

This is a compressed file that needs to be uncompressed with a good utility. It is double
compressed. When you get the file uncompressed you will see why the download is so big.

Name 4| Date Medi...
L5017034_03420100411_B10.TIF 4/11/10
L5017034_03420100411_B20.TIF 4/11/10
L5017034_03420100411_B30.TIF 4/11/10
L5017034_03420100411_B40.TIF 4/11/10
L5017034_03420100411_BSO.TIF 4/11/10
L5017034_03420100411_B6Q.TIF 4/11/10
L5017034_03420100411_B70.TIF 4/11/10
L5017034_03420100411_GCP.txt 4/11/10
L5017034_03420100411_MTL.txt 4/11/10
README.GTF 4/11/10

R -

Size
59.3 ME
59.3 MB
59.3 ME
59.3 MB
59.3 ME
59.3 ME
59.3 MB

16 KB
66 KB
12 KB

Kind

TIFF image
TIFF image
TIFF image
TIFF image
TIFF image
TIFF image
TIFF image
Plain Text
Plain Text
Document

Now you are ready to add your combination of bands to a ArcGIS map. ArcMap/ArcToolbox

can allow you to work with multi-band images directly in ArcGIS

3. Using Landsat Images in ArcMap

Open ArcMap with Toolbox available

In Toolbox, expand DATA MANAGEMENT TOOLS: RASTER: COMPOSITE BANDS




e In the new window, you can import just the three bands you want to display in red-

green-blue (notice that you can change the order of the bands in the middle section)
and then save as an image (typically geotiff).

" Composite Bands 5
& InputRasters -
| =
o
x
T1<E
+
& OutputRaster B
| S
< I | ]
QK | Cancel Environments... | Show Help == |

e You can also import all of the bands into a single image remembering that only the

first3 bands will be displayed. The advantage here is that you can reorder the bands
in ArcMap, under PROPERTIES: DISPLAY
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